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USING THE ARfiR FILE ON CD-ROM 

1. WELCOME 

Welcome to the Cannon Air Force Base (AFB) Administrative Record (AR) File on CD­
ROM (Compact Disk Read Only Memory). This set of CD-ROMs contains images of all 
installation restoration program documents in the AR file and the applications needed to 
search and view the images. With this information, you can perform detailed searches of the 
AR textbase to identify specific documents, and then view the selected documents page-by­
page or print selected document pages. For further information on the AR file, contact the 
Cannon Environmental Restoration office at (505) 784-1092. These instructions have been 
developed to walk you through the step-by-step approach of retrieving and viewing the 
selected documents. A copy of these instructions should be used with the set of CDs. 

2. THE ADMINISTRATIVE RECORD 

An initiative to establish AR files at each of the installations was performed by the U.S. Air 
Force Headquarters Air Combat Command (HQ ACC) during 1992-1994. The initiative was 
coordinated through the Headquarters Environmental Protection Agency (HQ EPA), EPA 
regional offices, and state regulatory offices, Secretary of the Air Force offices, Air Staff, 
HQ ACC, and base organizations. This initiative standardized the AR files at each ACC 
installation, and also created and standardized an information repository (IR) file (a copy 
provided for public review) for each base. During that time, the HQ ACC Legal office 
developed ACC guidance detailing specific types of documentation that would be considered 
and incorporated into the AR file. This guidance parallels the EPA's Office of Solid Waste 
and Emergency Response (OSWER) Directive 9833.3A-1, "Final Guidance on ARs for 
Selecting CERCLA Response Actions". 

The ACC guidance provides for an AR file that is the collection of all documents used to 
support the decision for selecting response actions at an ACC installation. Both the AR and 
IR files are updated as new documentation is made available, until all of the final response 
decisions have been made for remediating sites on the installation. 

To manage the documents in the AR file, HQ ACC developed an AR textbase consisting of 
32 datafields using INMAGIC® DBffextWorks™ software. This software allows the user to 
execute detailed searches on the AR datafields to select documents of interest. The runtime 
version of this software, DB/SearchWorks™, is included with the CD-ROM set (on CD 
Volume 1 ). The AR textbase consists of many records, one for each document in the AR 
file. A record contains information about the document - date, subject or title, author, sites, 
etc., along with a unique identifying number for the record identified as the ARIIR File 
Number. Not all datafields will be completed for each record. The sites and 
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hazard/contaminants listed in the AR textbase in the browser dialog boxes are described in 

Appendix A. 

Because of the large quantity of documents comprising the AR/IR files, storage at libraries is 

becoming an issue for many U.S. Air Force installations. To remedy the storage problem, 

HQ ACC implemented an initiative to scan ACC installations' AR files onto CD-ROM. 

HQ EPA approved use of this technology as an alternative to maintaining a hard copy of the 

IR. Cannon AFB is one of the ACC installations using this technology. 

3. BEFORE YOU START 

Before you start to use your AR/IR file on CD-ROM, it is recommended that you read these 

instructions so that you will understand the computer terms associated with the AR textbase. 

Previously, the Kodak CD Image Retrieval software was used to view the images. After 

Kodak no longer supported the product, a change was made to utilize INMAGIC® 

DB/TextWorks™ software for viewing the AR records. Refer to Section 6 to view the AR 

images on CD-ROM. 

Before you use the ARIIR file on CD-ROM, Volume 1 of the CD-ROM set will need to be 

copied on the hard drive of your computer. By copying Volume 1 on the hard drive, this will 

save you time from changing out CDs when you are performing a search query. (Note: 

Each time that the AR is updated, Volume 1 of the CD-ROM is also updated. Volume 1 will 

need to be copied on your computer each time that the AR is updated.) 

Place CD Volume 1 in the CD-ROM drive of your computer and copy the entire folder into a 

location where you will be able to find the folder. After you have copied Volume 1, you will 

not need to use this CD unless you would like to view the table of contents (TOC) of the AR 

textbase. NOTE: Due to new security patches and the Defense security policies as depicted 

in the following screen example for Shaw AFB, you may have trouble copying CD#1 on to 

your computer. You will need to contact your Information Management staff to give you 

"full administrative" rights for both the DBSearch software and the Imaging software, as 

well as the * .tbu and * .tba files. 
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4. SEARCHING THE ARIIR FILE TEXTBASE 

Searching is the process of finding information in the textbase. A search is a request to find 
all of the records that match specific requirements. By using the INMAGIC® 
DB/SearchWorks™ software, you will be able to search your textbase on any field or 
combination of fields, sort the results by the field of your choice, and output a report using 
one of five pre-designed formats that have been provided. You will run the 
DB/Search Works™ software directly from your hard drive of your computer after you have 
copied Volume I of the CD-ROM set on the hard drive. The index of the records 
(documents) in the AR file can be used as a reference when you search for a specific 
document in the AR textbase. It is recommended that you keep the current AR index with 
the set of CDs and the CD instructions. 

4.1 Developing a Search Strategy 
The first- and most important- step in any search is to develop a search strategy. To 
do this, you must identify the objective of your search: What are you looking for, and how 
do you want the results presented? If you are preparing a report based on the search results, 
how much data from the index do you want to display? 

'Qlere are 32 fields in the textbase providing a variety of information about each ARIIR file 
document. The field labels, field names, and a brief description of each field are provided 
below, in the order they appear in the QBE window. In addition, there are two other fields, 
Image and CD Volume, which provide information; however, they are not searchable fields 
in the QBE window. 

• FILE_NUM (ARIIR File Number): The unique identifier for each document. 

• IRP _FL (IRP File Number): The file code from the installation file plan. 

• FL_LOC (File Location): The location of the document. 

• TYPE (Document Type): Description of the document type, such as plan, 
correspondence, memorandum, etc. 

• QUAL (Document Qualifier): Description of document quality or status. 

• DATE (Document Date): The date of the document. 

• REC_DATE (Receipt Date): The date the document was received at the 
environmental office. 

• SUffl (Subject/Title): The title or subject ofthe document. 

• AU (Author): Name of the individual(s) author. 

• AU_AFF (Author Affiliation): The organization or agency with whom the author 
is affiliated. 

• CORP _AU (Corporate Author): The name of a company or agency author. 

• RECIP (Recipient): Name of the document recipient. 
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• RECIP _AFF (Recipient Affiliation): The organization or agency with whom the 
recipient is affiliated. 

• ATICHMT (Attachment): Description of the attachments to a document. 

• COPY_TO (Copy To): Name of person or agency receiving a copy ofthe 
document. 

• KEYWORD (Keyword/Environmental Resource): The environmental resource 
affected, or other keywords. 

• NOTES (Notes): Additional information about the document. 

• SITE_NUM (Site Number/Name): The IRP site number and name. 

• HAZ_ CONT AM (Hazard/Contaminant): The hazard or contaminant discussed 
in the document. 

• EPA_FILE_NUM (EPA File Number): File code referencing EPA's file 
structure that best describes the CERCLA or RCRA process. 

• OU (Operable Unit Name or Number): The name or number of the IRP operable 
unit. 

• PROJ_NUMBER (Project Number): The USAF-assigned project number for 
contracts. 

• ROD_ DATE (Record of Decision Date): The date of a final record of decision. 

• DATE_ENT (Date Record Entered): The date the record was entered into the 
AR textbase. 

• DATE_MOD (Date Record Modified): The date the record was modified in the 
AR textbase. 

• EPA_REGN (EPA Region Number): The EPA region where the installation is 
located. 

• INST _CODE (Installation Code): The unique three letter identifier for the 
installation. 

• INST_NAME (Installation Name): The installation name and state where 
located. 

• MAJCOM (Major Command): The major command to which the installation 
belongs. 

• PR_DA (Privacy Data): This field references any Privacy Act information in the 
document. 

Use the most logical textbase field for your search. For example, if you are searching for 
TCE, a contaminant, use the HAZARD_ CONTAMINANT field for your search, rather than 
the SUBJECT_TITLE field. Ifyou are searching for site information, use the SITE_NUM 
field. (NOTE: Some of the textbases contain "All Sites" term under the SITE NUM field. 
When you are searching for a specific site, you must also include "All Sites" if it is listed in 
the SITE_NUM field. As textbases are updated, the "All Sites" term is being removed.) 
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Depending on how a field is indexed, you can search for a word, phrase, or term: 
• A word is a group of characters that does not contain spaces or punctuation 

(except a decimal symbol in a number). 
• A phrase is two or more words separated by spaces, or in some cases, 

punctuation, such as waste oil or FT -03. 
• A term is a word or phrase that is also a complete entry in a field. Date and 

number fields typically are term indexed, as are fields that hold discrete pieces of 
information, such as the subject/title field. 

A search item is a single word, phrase, or term that you find in the AR textbase. You can 
specify one or more search items in a QBE box. A search item could be a single 
comparison, range, or proximity search request. For example, >100, or 1997, or RI Phase 2 
are all search items. 

4.2 Using Boolean Operators 

Before we go any further in our discussion of searching, let's talk about search ''theory." 
You will use tools called Boolean operators - AND, OR, NOT - to expand and limit 
searches. 

Suppose you are looking for a document that pertains to Site FT -06 and was written by the 
EPA. The AND operator limits the search to those documents that are both about Site FT -06 
and from EPA. Documents that are about Site FT -06 but not from EPA, and documents 
from EPA that do not pertain to Site FT -06, are excluded from the fmdings. Only 
documents that meet both criteria will be included. This is probably the most common type 
of search you will use. 

Perhaps you need to find all documents that pertain to Site FT -06, from all sources, as well 
as all other documents from EPA. The use of the OR operator expands the search. Findings 
will include all documents that meet either criterion. As you can see, this will result in a 
much larger set of search findings. 

Perhaps you need to search for all documents pertaining to Site FT -06 except those from 
EPA. The use of NOT limits the search in a different way than the use of AND. The 
findings would include only those Site FT -06 documents that meet both criteria - about Site 
FT -06 but not from EPA. In other words, the FT -06 documents from EPA would be 
excluded from the search findings. 

4.3 Understanding the Browse Feature 

The Browse function is one of the most useful features of DB/Search Works™, allowing you 
to examine the actual contents of each indexed field during the search process; thus, 

Using the AR/IR File on CD-ROM - Rev 06/05 5 



eliminating the guesswork in searching. You can paste items from the lists into the QBE 

boxes to search for documents to which these criteria pertain. Pasting is recommended 

because it is more accurate, and often quicker, than typing. By pasting a word or term, you 

guarantee that it matches information in the textbase. Otherwise, if your datafield entry is 

not in the correct format, it may not be recognized by the query. 

While in the QBE form, you can browse through the entries in a given field either as terms 

or words. To browse, place the cursor in the box for the field you wish to browse, and click 

on the Browse icon or press F3. Terms appear in the Browser dialog box. As mentioned 

earlier, the lists of the sites and the hazard/contaminants found in your AR textbase in the 

Browser dialog boxes for these two datafields are described in Appendix A. 

For example, the following screen illustrates the query choices available for pasting in the 

Type datafield. The number at the beginning of each line indicates the number of records 

that contain the word or term shown. You can paste terms or word into the QBE form by 

double-clicking the selection or clicking paste. 

Application Permit 
Charter 

··I I- II 1-

1 Data 
2 Fact Sheet 
1 Form 
1 Index 
36 Meeting Agenda Minutes 
18 Memorandum 
1 0 Newspaper Article 

4.4 Finding Records 

After determining your search strategy, you are ready to begin searching the textbase. When 

you open the textbase, you see the QBE window. Each box on the screen represents a field 

that you can search. There are two basic techniques that you can use to find records: 

6 

• Typing the information required in one or more field boxes, or 

• Using the Browse feature (the Eyeball button from the toolbar row) to select 

words or terms. 
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To find records that satisfy multiple conditions, type or paste information in two or more 
boxes, then toggle the Boolean operator button in front of a box (AND, OR, NOT) to 
determine how the result of the search in that box is combined with boxes already evaluated. 
To toggle a Boolean operator button, click the button with the mouse or tab to a button and 
use the spacebar. 

For example, let's find all correspondence related to Site FT-06 that was written after 1992. 
Start the search by opening the DB/SearchWorks™ software and beginning at the QBE 
screen. 

4.5 Starting the DB/Search Works ™ Software 

... 

a. In Windows 3.1, choose Run from the Program Manager File menu. For 
Windows 95/98/NT and later, click on the Start button and select Run. 

b. At the Run window, type in the path of where the DBSGRSCH.EXE file is 
located that has been copied on your hard drive of your computer previously from 
Volume 1 ofthe CD-ROM set. The path of the DBGSGRSCH.EXE file has been 
typed in below where C is the drive letter. After you have identified the path, 
select OK . 

Run I? lfx.l 

f.·liJ.:.···•.·I.·· ... • Typ(;!tf'len~e.'Qf~prq~rl9m,. folder .. documentJ or . · . . . .. Iot:ern~t r~source;, and Windows wiJI open it ·for you . 

......,.__c ..... a ..... nc ..... e_l __ ) [ Browse... . ) 

NOTE: You may also open the DB/Search Works™ file by locating the 
DBSGRCH.EXE in the folder where you copied CD#1 to your hard drive by going 
through "My Computer" and then double-clicking on the file. The 
DB/Search Works™ software will open the run-time window display as shown in the 
next screen. 
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8 

c. The Inmagic DB/Search Works™ 2.1 Run-time window will be displayed. 

d. NOTE: Before you open the cannon.tba file, make sure that you have properly 

identified the CD drive that you will be using to view the scanned images of the 

documents in the AR textbase. First, choose User Preferences from the File 

menu. Then, from the Preference Group, highlight Imaging word. Once you 

have highlighted the "Imaging" word, the imaging preferences box will appear. 

Use the pull down menu for the image drive to select the CD drive that you will 

use to view the scanned images. After you have identified the CD drive, select 

OK and you are now ready to Open the cannon.tba file. 
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e. Let us now continue with the sample search query provided above. Choose 
Open from the File menu or Click on the yellow folder icon on the toolbar. The 
Open Inmagic DB/TextWorks Textbase window appears. Select cannon.tba 
from the resulting dialog box then select OK to open the Cannon AFB ARIIR 
textbase. 

12:> c:\ 
J27 ADMINREC 
a. CANNON 
L:J TOC 

Jliiiil c: 
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f. The Query by Example (QBE) window will now be on your screen. Each box on 
the QBE screen represents a field you can search. 

FL LOC MDj.__ _____________________ _..w 

lYPE 
AMDj.__ ________________ ~----~ 

QUAL 
' ANOI '--------------""' 

DATE :»mj.__ ____________________ ~ 

REC DATE 
MOj.__ ______________________ ~ 

su 11 MDj.__ ______________________ -w 

AU 

g. The first criteria (FT -06) can be pasted in the SITE_ NUM field box by using the 
browse function. Place the curser in the SITE_ NUM field box and select the 
Eyeball icon on the toolbar or press F3 to browse. 

~oj.__ ______________________ ~ 

COPY TO MIDI .___ ____________________ _..:;,o 

KEYWORD 
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h. The Query Choices Browser for SITE_ NUM will appear. Select Ff -06 from the 
list and choose Paste, then Close. 

Query Choices Browser: SITE_NUM £I 
£.il'ld: 1FT -06 

Choi.:&• .b.i•~ 0 
• 
177 
178 
195 
169 
150 
219 
217 
380 

!j4 

FT -07 Fire Department Training Area 2. SWMU""-' 
FT -08 Fire Department Training Area 3. SWMU 
FT -09 Fire Department Training Area 4 
LF-01 Landfill No 1. SWMU 74 ..;.....J 
LF-02 Landfill No 2. SWMU 82 
LF-03 Landfill No 3. SWMU 105 
LF-04 Landfill No 4. SWMU 104 
LF -05 Landfill No 5. SWM U 11 3 

I LF-25 Concrete Rubble Pile_ SWMU 97 .. r 

Paste I· 
Print List... I 

Clo11=e .. 1 

. r Words u;J ' Fj&ld: 1..! S._· I._T_;;E;;,:: .. ;;;..:N..;:,U.::...:..,M.;_..,...,....,...,._.,........, ___ ....,......~•=!IU. 

i. The second criteria (documents after 1992) can be typed in the DATE field box. 
In this case, documents after 1992 are identified by using the search item > 1992. 
Place the curser in the DATE field box and type >1992. 

DATE 

-~~I>I~m~--------------------~ 
REC DATE 

~1~------------------
su Tl 

~~--------------~ 
AU 

·~~----------------~ 
AU AFF 

~~----------------~ 
CORP AU 

j. The third criteria (documents that are correspondence) can be pasted in the TYPE 
field box using the Browse function. Place the curser in the TYPE field box and 
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select the Eyeball icon on the toolbar or press F3 to browse. The Query Choices 

Browser for TYPE will appear. Select Correspondence from the list and choose 

Paste, then Close. 

Query Choices Browser: TYPE , £1" 
find: 
Choices list: Number of entrie$ pasted: 0 
2 Application Permit 
1 Charter 

... Paste 

440 Cones ondence 
l Data 
2 Fact Sheet 

Print lisL. I 
Close I 1 Form 

1 Index 
36 Meeting Agenda Minutes 
18 Memorandum 
1 0 Newspaper Article 

• .. Help... .1 

[UStShowl 
Terms: List r Words: List F.\f:ld: I TYPE .=JI 

k. Now, make sure that all Boolean operator boxes for the three datafields are 

AND to ensure that all documents that refer to correspondence, > 1992, and 

pertains to Site FT -06 are included in the search (according to . our search 

criteria). 

Fl LOC •oiL_ __________________ ~~ 
TYPE 

ANDjf-c.,....opondonc~ 
QUAL 

ANDIL---------------------~~ 
DATE 

~~l~>l=m~--------------------~ 
REC DATE 

~I L----------------'"'"' 
su n 
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I. To execute the query, just click the Go button on the QBE toolbar or choose 
Execute Query from the Search menu. 

. FL LOC 

M~l~------------------
TYPE 

.~11-couespondtnce 
QUAL 

•1~----------------~ 
DATE 

... , ~1>1=992=------------..:.1 
REC DATE 

~~----------------~ 
su 11 

~~~----------------~ 

m. After executing the query, a DB/Search Works™ message window appears 
reporting how many records met your search criteria. If there is a match, you can 
view them in the report window by selecting Yes. 

lnmagic DB/SearchWorks Message I 
QuerY found 48·records. 
Do you want to view them in the Report window? 

YM J __ N_o __.I 
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n. At any point in the query process, you can clear all the fields and enter new 

search criteria by clicking the New Query button on the QBE toolbar or choosing 

New Query from the Search menu. 

IRP Fl ANOI L.__ __________ _.... 

· Fl LOC . ANI)j ,__ _________ ___...:;,o 

TYPE 
ANI)JI-corrupondenc~ 

QUAL 

. ANPI L----------------'-' 
DATE 

»~oll"-'>'=mo..-__________ ....,:±1 

REC DATE 

ANI)j '----------------
su Tl 

4.6 Closing the DB/SearchWorksTM Software 

You can close your DB/Search Works™ session at any time by choosing Exit from the File 

menu. 

5. VIEWING AND PRINTING REPORTS 

5.1 Formatted Reports 

After retrieving a set of records from your query, you can view and print a report of your 

results in a variety of defined formats or you can view the scanned images with the selected 

set of records using the CDs associated with each record by removing CD# 1 and replacing it 

with the CD that is associated with the record you would like to view (R~fer to Section 6 for 

viewing documents.). The five available report formats were developed to meet the needs of 

U.S. Air Force personnel and members of the public interested in viewing AR file 

documents. These report formats are: 

• the ImageNum format, 

• the EP Alndex format, 
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• the Longlist format, 

• the Shortlst format, and 

• the Site/st format. 

All the reports provide basic identifying information about each AR file document, including 
the AR file number, subject/title, author, and document date. For the purpose of selecting 
AR file documents to view, the ImageNum report will be most useful as it also identifies 
which volume of the CD-ROM set holds the AR file documents you want to view. 

A sample ImageNum report printed for our previous query example is shown below. 

t--AD. Jill c ..... AD.-
~-Aalla ............ ca""-'t_.....,.. • ....,._..,_. 

.... ...-:t~.~~~nlll5 ....., .... ; fi.W!tt5 

C1l £llllll- --- CB -- ---- -.. 
__ ....., 

..._...,_ - - --- .,_...,..._ 
OF" ... Biii~~41iimcDJilfiliiilnc.-----u'?- lrsPTIJicc--- ~-=-=--Jiiiii~~~- FSPTMC-
I .... 1 .. lWI_s.....,....,...,.., 
~ "" lftllll) l.ttkta ... Clatedaci.Ci.A Colnc:Drt --- F 114 BIM~tD lli.B NaltlcJ Cmv:mdD& l1SPTM:C -- - h II.BIIIMI::incSchtdiiJII4k 14 J.ucSt'l 

~ .., BM:tL~ttcWMt;rlriJlCloril ~I.All l1SPl'GICC b 131 B.se.....__toi.AB!llmilm~ 21SPTGICC 

~ I JU.B lllla'cfiD:I:IH <ft ,., 1M .. , BMtiAI1ctoNJm)~toma:D'' :z7SPT(UCC 

I lltqatst.~~Stes:tr.• I' 135 ll~~~n~toi.AllllllabaC~ 21SPTOICC w-.K ~tW~~RJ.J~~•btsrre 

~ ... P«bJH~Sdleokl.ltbrtoBve ......,, F 744 »-e 1*-onrllbUo BAll HabcJ CaN:tmiDc 21s»TGICC 
~..-o ... «ChdllknDto 1hiRABllfett:kc:Oill1Btp91 

I s-. ~tlle ii.J Bolri. ~ , ... B.e~to RAB16:a~Mn. emc.mnc. 27SPTGICC 

F ... .....~toi.AI...-..~ 71SPT'Gf'CC I tt.RABHttdngaa 28Ja99 
thtUlllllldlc~lO Da.t6 

b r 156 hn~toi.AliBodJM.ba 21SPTGICC 
100 IAI:tatollwe~~r1 CCIIIC'IIIDw CwtJ111:kaat28*!JIPIAB 

I .......,., CwJaclra.s•MlW:Ic"dlhti.AB 

·I 
~Dultoh:~~-
RHdudaltdt.'4Mw99 

I' 105 lu•......_toiJ.BM.ba CCDtel'drl&: 71SPl'GfCC 

I tbiiU.B Mtttltc~kl1 Jtb j)J 

I 

5.2 Selecting Report Forms 

a. Choose Select Forms from the Display menu. The following window appears. 

Select Forms I:J 
Currently U"ing: ---·---------- -=----

liR~c~c(Di•IIJf.liJ' ... I Basic Record Form 

ft811Jort.WirtcJowc.; I IMAGENUM (public) 

>R~po•tPtmtin~ ... I IMAGENUM (public) 

J:. .OK I Caneel 
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D e"cription: 

The Basic Record form shows each field in the 
te)(tbase. <automatically generated> 

imported from INMAGIC/DOS file SITELST.FMO 
(Created: 9/25/9B 9:04:15 AM) 

imported from IN MAGIC/DOS file SITELST.FMO 
(Created: 9/25/98 9:04:15 AM) 

Revert to Default• Help ... 
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b. To select a form for a particular operation, click one of the three buttons: Record 

Display, Report Window, or Report Printing. 

c. A dialog box displays the forms available for that operation. The basic report 

form provided by DB/Search Works™ is listed first, and then the forms designed 

specifically for AR file documents are listed alphabetically. The form currently in 

use is highlighted in the dialog box. 

Select Report Window Form EJ, 
Currently Saved: 
8 asic Report Form 
EPAINDEX (public} 
II:":J'.:.'U1ll~liJ;";•rm:t• I!i 
LONGUST (public) 
SHORTLST (public) 
SITELST (public) 

Selection: IMAGENUM 
Created: 9/25/98 9:04:15 AM 
Description: imported from INMAGIC/DOS file SITELST.FMO 

I >Ok .I 
.•. tt~el I 

•. h'&Ye•ttoDef.,aull: I 
. 

d. Select a form or click Revert to Default to assign the textbase default form for 

the operation identified in the title bar of the dialog box (the default form for the 

Report Window and Report Printing has been set to ImageN urn). Then click 
. OK. 

5.3 Printing a Report 

When you have selected your preferred forms and executed a query, you are ready to print a 

report. 

~ Note the default report, ImageNum, includes the CD-ROM volume and ARfiR file 

number for each record in your query. You will need this information to view ARfiR 

file documents. 

There are two ways start a print report. 

• Click the Print icon on the toolbar, or 
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AND 
275 Base Letter to EPA Region VI Concerning RFI 

AND Phase 11 Investigalion Delay 

AND 

~5 TI7 NMED Letter to Base Concerning Discharge Plan 
Application 

AND 
378 NMED Letter to Base Concerning Rl Report for 18 

AND SWMUs 

AND~ 447 EPA Region VI Lettet to Base Concerning RFI 
Phase 11 Report for AppendU< I SWMUs 

AND 6 450 Base Letter to EPA Region VI Concerning Notice 
of Deficiency for RFI Phase ll Report 

AND 
--6 468 EPA Region VI Letter to Base Concerning Notice 
AND of Deficiency for Phase lli RFI Work Plan for 

AppendU< I SWMUs 

~6 470 Base Letter to EPA Region VI Concerning 
Establishment of RAB 

AND 

• Choose Print from the File menu. 

Wrte Report to Fie ... 

Ext 

I C'\AOMINREC\CAN«>N\CANNON 
2 C'\ADMIN<EC\-ITEMAN\WHITEMAN 
3 C:\AOMINREC\MINOT\MINOT 
• C\AOMINREC\BARI<SDAL\BARl(SDAI. 

m 
AND 

AND 6 447 

AND6 450 

AND 
--6 468 

A!IID 

. AND~ 470 

AND 
~ 471 

NMED Letter to Base Concerning R1 Report for 18 
SWMUs 

EPA Region VI Letter to Base Concerning RFl 
Phase 11 Report for Appendix l SWMUs 

Base Letter to EPA Region VI Concerning Notice 
of Deficiency for RFI Phase II Report 

EPA Region VI Leiter to Base Concerning Notice 
of Deficiency for Phase III RFI Work Plan for 
Appendix I SWMUs 

Base Letter to EPA Region VI Concerning 
Establishment of RAB 

Base Leiter to NMED Concerning Establishment of 
RAB 
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27FW/CC 

New Mexico Environment 
Deportment 

New Mexico Environment 
Department 

EPA Region VI 

27SPTGICC 

EPA Region VI 

27FW/CC 

New Mexico Environment 
Dep--

New Mexico Environment 
Deparlment 

EPA Region VI 

27SPTGICC 

EPA Region VI 

27FW/CC 

27FW/CC 

24 Jun 92 

09 Oct 92 

23 Aug 94 

23 Sep 94 

09 Jun 95 

14 Jun 95 

24 Jun 92 

09 Oct 92 

23 Aug 94 

23 Sep 94 

09 Jun 95 

14 Jun 95 

14 Jun 95 
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6. VIEWING DOCUMENTS WITH THE INMAGIC® DB/SearchWorks ™ 

SOFTWARE 

The following instructions will guide you through retrieving, viewing, and printing ARIIR 

file documents. Once you have completed the search query and identified the record you 

would like to view, you may place the CD volume containing the record you wish to view 

into the CD-ROM drive. 

AND 

AND 

AND 

~5 

AND 
--5 

AND 

AND 6 

AND 6 

AND 
--6 

AND 

AND 6 

AND 

18 

a. Now, go to the toolbar and you will see the button that contains a scene that is 

titled, "show record image", click on this button and it will take you to the 

selected image of the record. 

r75 Base Letter to EPA Region VI Concerning Rfl rlFWICC 12 Jan 93 

Phase II Investigation Delay 

377 NMED Letter to Base Concerning Discharge Plan New Mexico Enviromnent 24 Jun 92 

Application Depa<mlent 

378 NMED Letter to Base Concerning Rl Report for 18 New Mexico Environment 09 Oct 92 

SWMUo Department 

447 EPA Region VI Letter to Base Concerning RFI EPA Region VI . 23 Aug 94 

Phase II Report for Appendix I SWMUs 

450 Base Letter to EPA Region VI Concerning Notice r7SPTGICC 23 Sep 94 

of Deficiency for Rfl Phase II Report 

468 EPA Region VI Letter to Base Concerning Notice EPA Region VI 09 Jun 95 

of Deliciency for Phase III RFI Work Plan for 
Appendix I SWMUs 

470 Base Letter to EPA Region VI Concerning rlFWICC 14 Jun 95 

Establishment of RAB 

471 Base Letter to NMED Concerning Establishment of rlFWICC 14 Jun 95 

RAB 

b. The record you selected is automatically opened in an image window. The 

document page count is shown in the image window title bar. Maximize the 

windows on your desktop for the best image quality. 
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AND 

AND 

AND 

AND 

, AND 

AND 

AND 

AND 

AND 

AND 

Al\10 

~' 

~' 

t.N!> 

AIIID 

~ 
AND, 

AI!«> 

~ 

AND ,--

• 
CANNONAFB 
NEW MEXICO 

ADMINISTRATIVE RECORD 
COVER SHEET 

AR IItle Number_-"'~1"'-0 __ _ 

12Jan93 

24 Jun 92 

09 Oct 92 

23 Aug 94 

23 Sep 94 

09Jun 95 

14 Jun 95 

14 Jun 95 

c. Adjust the view as needed by Magnifying or Rotating the image using the 
options under the Image menu or by selecting the appropriate Magnify or Rotate 
icons on the toolbar. 

d. 

CANNONAFB 
NEW MEXICO 

ADMINISTRATIVE RECORD 
COVER SHEET 

AR fo"D<! Number --""~J"'-0 __ _ 

09 Oct 92 

23 Aug 94 

23 Sep 94 

09 Jun 95 

14 Jun 9S 

14 Jun 95 
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~ 

~ 

AND ,--
~ 

AI$ 

~ 

~ 

~0 

liMP 

'AMP< ...., 
~. 

~ 

ANb 

~ 

20 

e. 

f. 

lJ Jan 93 

24 Jun 92 

09 Oct 92 

..... 
rnr. .. ,.~~,:....._-~oo< ..... 

23Aua9-4 

uo...lii ..... CII.-

23 Sop 9-4 

09 Jun. 95 

14 Jun 9S 

14 Juo 9~ 

Navigate through the document by using the options under the Image menu by 
selecting the ''Next Image" or "Jump to Image" or by selecting the scene and 

arrow icons on the toolbar. 

To view a new document, make sure the correct CD volume is in the CD-ROM 

drive for the next document you wish to view and repeat the retrieval process 

from step a. 

g. To print one or more pages of the document, choose Print from the File menu. 

12 Jan 9l 

24 Juo'92 

09 Oct 92 

·-.......... ",..-.,_~ .... 23Aua:94 

23 Sep 94 

09 Juo 95 

14 Jun 95 

14Jun 9'5 
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h. Choose OK and the Select Images to Print Screen will appear. 

--------~-~ :-'=--~-~~-~J 
--~~;;;;;;;;-~=.V=cr,=_ r-:=~~=::~.-i;~=r-=-~-:::==-~~~ r::;~--~~---~-~ 

~~-~t:7Coil"'"l 
L. --'-------~---------~----·---- _, 09 Oct 92 

,\1111).. . """ l Ot( - c..,... I 
Nm:~~~~------~~~~~~ 23 Aug 94 

23 Scp 94 

09 Jun95 

14 Jun 95 

14 Jun 95 

i. You can either check to print the current image or print all the images in the 
current AR record you are viewing or you can print out all images in the set 
(query). 

· AIIID 

~' 

AND' 
~·--· 

AND 

AND 

AND 

r- Prinl n- --- ----------------­

, i r Print eunem •·-
] ~ Prinll.agea in the Current Record 

L' Prinll:-~-~-~~~at_-~--
Selecti-FIIIIda: 
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09 Oct 92 

23 Aug 94 

23 Sep 94 

Region VI 09 Jun 95 
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AND 

AND 

AND 

AND 

AND 

AND 

AND 

AND 

AND 

22 

j. When you are done viewing documents, exit the screens by clicking on Close of 

each screen until you return to the original query by example screen and then you 

may start a new query. 

= ~~~:':~ ~~.,.~ ~~·~z,~"~~~~ 
.....,., )J-.,. 'lt. )ueJJ.aa ..Qclll :nr ... "::llll nl¥-1tM.-•u. ,.,. .,.., 'l:oos•,.. t'J. 

r• ..... l••.t"--oo."'WII ...... ~l'ft..tt • .,_~Mtlw.t"'-.:u.i:n:aflt:.jc..-... c:..,.,.,.to1 'ld.tliiL., tftrtote:l macM. 

lil!.o'lo•~~r.-.1 ,,..,.,.,, •• ,_,..,l.,, .. ,,,..~·ll.l\h:J•t•t• tbt 
r • ...a... '"':1- .,... .. _14ht .. ~·" ~1.<1-t• t'M Pl'gJ=cJ:: V die ~ac! ~ 
~t~n.• .. 7.1 LoOIIo 'f:i-. ,... a.r .. au.--11, ~''J:.II illnl"' or.t- t;l '::W M~ o~ 
.. 'JI'.II::'Ii.c,; tM ~:J;;b~~od t~~:~:t. ~~Lr&oe. 

r~ ,. .. law _,. .-.... ut.a~: ,~ aU! ,._ ·"• u:flll.u·.:• w: """· """"'- ,...1 .. .,, 
(:10) .'"14•27H. 

't,\."O'ILJC..')D!Jol!ll.l:ol-l,.Jnl&r .....,u ,..,. 
r ..... !-.tlr--.t;.:lo.:'hoi'loi!.G: 

12 Jan 93 

24 Jun 92 

09 Oct 92 

23Aug 94 

23 Sep 94 

09 Jun 95 

14 Jun 95 

Using the AR/IR File on CD-ROM - Rev 06/05 



1 his page intentionally lejt blank · 

Using the AR/IR File on CD-ROM - Rev 06/05 23 



APPENDIX A 

Sites listed in the AR Textbase: 
AOC-36 Disposal Pit 
AOC-D Nonfriable Asbestos Burial Pit 
AOC-1 Aboveground Oil Storage Tanks 
DP-16 Solvent Disposal Site, SWMU 81 
DP-33 Disposal Pit 
DP-35 Boresight Mound, AOC F 
FT -06 Fire Department Training Area 1, SWMU 78 
FT -07 Fire Department Training Area 2, SWMU 106 
FT-08 Fire Department Training Area 3, SWMU 107 
FT -09 Fire Department Training Area 4 
LF-01 Landfill No.1, SWMU 74 
LF-02 Landfill No.2, SWMU 82 
LF-03 Landfill No. 3, SWMU 105 
LF-04 Landfill No.4, SWMU 104 
LF-05 Landfill No. 5, SWMU 113 
LF-25 Concrete Rubble Pile, SWMU 97 
LF-36 Potential Old Landfill, AOC G 
LF-37 Potential Old Landfill, AOC H 
OT -10 Blown Capacitors Site, AOC C 
OT -23 Melrose Bombing Range 
OT-24 Conchas Lake Recreation Annex 
OT-27 USTNear Bldg 120 
SD-lla, b, c Engine Test Cell, Overflow Pit, leach Field, SWMUs 86-88 

SD-11d Evaporation Pond, SWMU 89 
SD-lle Oil/Water Separator No 5114, SWMU 90 
SD-12 Storm Water Collection Point, SWMU 85 
SD-13 Sanitary Sewage Lift Station Overflow Pit, SWMU 75 

SD-15 AGE Drainage Ditch, SWMU 34 
SD-17 Old Entomology Rinse Area, SWMU 96 
SD-20 NE Stonnwater Drainage Area, SWMU 95 
SD-26 Waste Oil Tank and Overflow Capacity Tank 
SD-34 Rubble Pile, AOC E 
SS-18 JP-4 Fuel Spill, AOC B 
SS-19 MOGAS Spill, AOC A 
ST-22 Underground Waste Oil Tank 
ST-25 Underground Waste Oil Tank 
ST -26 UST Old Service Station 
ST-26a and b Underground Waste Oil Tank, Aboveground Overflow Capacity Tank, 

SWMUs 48a and 48b 
ST-27 Sump, SWMU 83 
ST-28 Recovered Diesel Tank No. 108 

24 Using the AR/IR Ft1e on CD-ROM - Rev 06,105 



ST-29 Recovered Diesel Tank No. 121 
ST-30 Inactive Underground Tank 1 
ST-311nactive Underground Tank 2 
ST-321nactive Underground Tank 3 
SWMU 1 (OWS No 119) 
SWMU 101 (Wastewater Treatment System-Eftluent Discharge) 
SWMU 102 (Wastewater Lagoons) 
SWMU 103 (Wastewater Playa Lake) 
SWMU 108 (Explosive Ordnance Disposal Training Area) 
SWMU 109 (Fire Training Area No. 4, UWO/OWS Tank No. 2336) 
SWMU 11 (OWS No. 179) 
SWMU 110 (Fire Training Area No. 4, UWO/OWS Tank No. 2336) 
SWMU Ill (Fire Training Area No. 4, UWO/OWS Tank No. 2336) 
SWMU 112 (Fire Training Area No. 4, UWO/OWS Tank No. 2336) 
SWMU 114 (EOD Burial Site) 
SWMU 115 (Explosives Contaminated Burial Site) 
SWMU 117 (Domestic Waste Pile) 
SWMU 118 (Explosive Ordnance Disposal Range) 
SWMU 124 (Inactive Underground Tank I) 
SWMU 125 (Inactive Underground Tank 2) 
SWMU 126 (Inactive Underground Tank 3) 
SWMU 127 (Sand Trap and Leach Fields at the POL Washrack) 
SWMU 128 (OWS No. 4095) 
SWMU 129 
SWMU 16 (OWS No. 680) 
SWMU 2 (Recovered Diesel Tank No. 1 08) 
SWMU 3 (OWS No. 1 08) 
SWMU 31 (AGE Maintenance Shop Pad) 
SWMU 32 (OWS No. 186 (#1) 
SWMU 33 (OWS No. 186 (#2) 
SWMU 36 (MWR Auto Body Shop) 
SWMU 38 (OWS No. 194) 
SWMU 39 (OWS No. 195) 
SWMU 4 (Recovered Diesel Tank No. 121) 
SWMU 46 (OWS No. 196) 
SWMU 47 (OWS No. 494) 
SWMU 49 (Inactive POL Storage Tank No. 4028a) 
SWMU 5 (OWS No. 121) 
SWMU 50 (Inactive POL Tank No. 4028b) 
SWMU 51 (OWS No. 375) 
SWMU 55 (Lead Acid Battery Accumulation Point) 
SWMU 57 (OWS No. 379) 
SWMU 6 (POL Tank No. 129) 
SWMU 61 (OWS No. 5077a) 
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SWMU 62 (OWS No. 5077b) 
SWMU 63 (OWS No. 326 and Leach Field) 
SWMU 7 (OWS No. 165) 
SWMU 70 (OWS No. 326) 
SWMU 71 (Recovered JP-4 Tank No. 390) 
SWMU 72 (OWS No. 390) 
SWMU 76 (Sludge Weathering Pit) 
SWMU 77 (Civil Engineer Container Storage Area) 
SWMU 79 (Underground Tank) 
SWMU 8 (OWS No. 165) 
SWMU 81 (Solvent Disposal Site) 
SWMU 9 (Acft W ashrack Drain Sys) 
SWMU 91 (Recovered Fuel Tank No. 5114) 
SWMU 92 (OWS No. 5120) 
SWMU 93 (OWS No. 5121) 
SWMU 94 (OWS No. 5114) 
SWMU97 
SWMU 98 (Sanitary Sewer Line) 
UNK 
WP-14 Sludge Weathering Pit, SWMU 76 
WP-21 Wastewater Treatment System Lagoon 

Hazards/Contaminants listed in the AR Textbase: 
Airfield Pavement 
Asbestos 
~.fsphatt 
'!' 
~.sphalt Rubble 
t1hitding Demolition Material 
Concrete 
Diesel 
Effluent 
Empty Cans 
Empty Drums 
Fuel 
Grease 
JP-4 
Leaded Gasoline 
Munitions 
Oil 
Paint Strippers 
PCBs 
Pesticide Containers 
Pesticides 
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Petroleum Hydrocarbons 
Practice Munitions 
Refuse Rubble 
Scrap Metal 
Sewage 
Sludge 
Solid Waste 
Solvents 
Stormwater Runoff 
Thinners 
Trichloroethylene 
Unexploded Ammunition 
Unknown 
Washdown Water 
Waste Water 
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